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Abstrak - Kualitas udara di sebagian kota besar saat ini sudah sangat mengkhawatirkan. Polusi udara yang berasal 

dari emisi gas buang kendaraan serta industri menjadi penyebab memburuknya kualitas udara. Debu yang 

dihasilkan oleh asap kendaraan maupun industri sangat berbahaya, bahkan jika kelamaan menghirup bisa 

menimbulkan penyakit pernapasan. Monitoring partikel debu dan suhu udara yang dimaksudkan untuk 

mengetahui sejauh mana tingkat pencemaran udara yang telah berlangsung sehingga dapat diambil tindakan untuk 

mengantisipasi dampak negatif yang ditimbulkan dari pencemaran udara, maka dari itu dalam penelitian ini 

dilakukan perancangan dan analisis komunikasi data terhadap perangkat Wireless Sensor Network untuk 

dikembangkan lebih lanjut dengan menggunakan ESP8266, Sensor MQ135, Sensor PMS5003, Sensor DHT21, 

Thinger.io sebagai visualisasi data pengukuran dan protokol komunikasi yang digunakan adalah MQTT dengan 

Mosquitto sebagai Message Broker dimana dapat digunakan untuk komunikasi atau bertukar pesan antar 

komponen dan MQTT Dash sebagai penampil di smartphone. Dengan adanya analisis komunikasi data ini, 

diharapkan mampu memperbaiki sistem yang sudah ada saat ini dan diharapkan mampu meminimalisir dampak 

negatif, menjadi bahan acuan perbaikan lingkungan. 

 

Kata Kunci: Mosquitto Broker, Thinger.io, MQTT, PMS5003, Wireless Sensor Network 

  

I. PENDAHULUAN 

 

Hadirnya teknologi memiliki pengaruh besar 

dalam kehidupan sehari-hari manusia (Leonita & 

Jalinus, 2018). Perkembangan zaman menimbulkan 

peningkatan aktivitas industri dan transportasi. Hal 

ini memicu timbulnya polusi udara yang berdampak 

pada kesehatan, terutama di wilayah industri dan 

kota besar (Kementrian Kesehatan Republik 

Indonesia, 2019). Meningkatnya volume kendaraan, 

serta pembuangan asap melalui cerobong oleh 

sejumlah industri, menyebabkan kualitas udara 

lambat lain sudah tidak sehat lagi.  

Menurut Peraturan Pemerintah No. 41 tahun 

1999 tentang Baku Mutu Udara Ambien Nasional 

menjelaskan mengenai batas – batas ambien 

maksimal yang berada di udara. Batas maksimal 

yang telah ditentukan adalah batas dimana suatu 

polutan akan berdampak negatif bagi lingkungan, 

sehingga suatu kota akan dapat dikatakan tercemar 

oleh suatu senyawa polutan apabila telah melewati 

batas tersebut (Cindewiyani, 2006). Tabel kategori 

Indeks Standar Pencemar Udara (ISPU) sebagai 

informasi terkait, dampak, dan status warna dapat 

dilihat pada tabel 1.  

Tabel 1. Kategori ISPU 

Kategori Rentang Status Warna 

Baik 0 – 50  

Sedang 51 – 100  

Tidak Sehat 101 – 199  

Sangat Tidak Sehat 200 – 299  

Berbahaya 300 - 500  

Saat ini, pemantauan polusi udara masih secara 

berkala sehingga dirasa perlu dibuatnya sistem 

monitoring polusi udara dan kepekatan debu yang 

dapat di monitoring secara realtime dan jarak jauh. 

Dalam penelitian ini dibuat prototype sistem untuk 

memudahkan pengukuran partikel debu dan suhu 

udara dalam lingkungan Kota maupun daerah 

sekitarnya.  

Untuk itu perlu dibuat sistem yang dilengkapi 

dengan ESP8266 sebagai mikrokontroler yang 

berfungsi melakukan kalkulasi dari pengukuran 

secara real-time menggunakan Sensor MQ135, 

Sensor PMS5003 dan Sensor DHT21 bertindak 

untuk mengirim pesan (publisher) lalu (subscriber) 

akan menerima pesan dan Mosquitto Broker akan 

menyampaikan pesan dari pengirim ke penerima, 

kemudian didapatkan hasil data yang akan 

ditampilkan kedalam website Thinger.io dan 

tampilan hasil pengukurannya menggunakan LCD 

sebagai penampil data numerik. Sistem ini 

bermanfaat untuk memudahkan pengguna/ 

pengelola agar mengetahui dan memberikan 

informasi kondisi lingkungan berdasarkan 

pembacaan polusi udara dan kepekatan debu yang 

berupa data sensor.  

 

II. KAJIAN PUSTAKA 

  

Penelitian mengenai monitoring kualitas udara 

telah banyak dilakukan. Prahardis, Syauqi, dan 

Akbar (2018) membuat sistem monitoring polusi 

udara berdasarkan ISPU menggunakan pemodelan 

Finite State Machine. Monitoring polusi udara yang 

mengukur karbon monoksida dan debu yang 
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berbasis website dapat dibangun menggunakan 

Raspberry Pi (Samsinar, Fikri & Fadliondi, 2021). 

Tidak hanya kadar karbon dioksida dan debu saja 

yang dapat dimonitoring, Sutarna, Fatah, Radila, & 

Wicaksana (2022) membuat pengukuran kualitas 

udara yang terdiri dari CO, O3 dan PM10. 

Pengukuran ini dapat dipantau jarak jauh dengan 

menggunakan arduino dan android studio.  

Monitoring radioaktivitas kadar polusi udara 

juga dilakukan oleh Yunita, et.al (2021). Konsep 

Internet of Things dapat diimplementasikan pada 

monitoring kualitas udara menggunakan MQ-7 dan 

MQ-131 secara real time (Prasetyo, Lamada, & 

Adzillah, 2021). Hasibuan, Asih, & Faisal (2020) 

memanfaatkan perangkat smartphone untuk 

melakukan monitoring suhu udara dan kelembaban 

udara di ruangan.  

Sistem pemantauan ketebalan debu dan suhu 

pada ruangan berbasis IoT dapat memberikan 

informasi hasil pemantauan menggunakan aplikasi 

Telegram (Maulana, Pratama & Kusumadiarti, 

2021). Syahrorini dan Hadidjaja (2020) 

memanfaatkan IoT untuk mengukur partikulat dan 

suhu lingkungan kerja pada suatu pabrik.  

Purbakawaca, et al. (2017) menggunakan  

sensor debu Gp2y1010au0f untuk mengukur PM10 

dengan biaya rendah. Informasi konsentrasi PM10 

ditampilkan di layar LCD dan disimpan dalam 

mikroSD. Algoritma Fuzzy Logic Tsukamoto dapat 

diimplementasikan pada sistem monitoring kondisi 

udara. Sistem ini juga memanfaatkan IoT dan 

menampilkan hasilnya pada telegram app (Sidik, & 

Rahmad, 2020). Sedangkan pada penelitian ini 

menerapkan LoRa dan protokol MQTT untuk 

memonitoring kualitas udara dan mengirimkan data-

datanya pada aplikasi Thinger.io yang merupakan 

platform Internet of Things. 

 

Pencemaran Udara 

Survei yang dilakukan oleh World Health 

Organization – WHO di 1.600 kota yang tersebar di 

91 negara di dunia menunjukkan bahwa hampir 90% 

orang-orang di pusat perkotaan menghirup udara 

yang tidak sehat. Dari berbagai jenis zat pencemar 

udara, benda partikulat atau particulate matter 

berdiameter 10 mikron (PM10) mendapatkan 

perhatian khusus karena dinilai memiliki pengaruh 

lebih besar terhadap gangguan kesehatan manusia 

dibandingkan dengan zat-zat pencemar lainnya. 

PM10 dapat dijadikan sebagai wakil dari zat-zat 

pencemar lain. Naik turunnya PM10 berasosiasi 

dengan zat-zat pencemar lain yang berada di udara. 

Oleh karena itu, sebagai prediktor kesehatan PM10 

mempunyai cakupan yang lebih luas (Masyarakat et 

al., 2016). 

 

Debu  

Debu merupakan partikel yang melayang di 

udara Suspended Particulate Matte (SPM) dengan 

ukuran 1 mikron sampai dengan 500 mikron. Dalam 

kasus pencemaran udara baik dalam maupun di 

ruang gedung (Indoor and Out Door Pollution) debu 

sering dijadikan salah satu indikator pencemaran 

yang digunakan untuk menunjukkan tingkat bahaya 

baik terhadap lingkungan maupun terhadap 

keselamatan dan kesehatan kerja (Sinolungan, 

2013). 

 

Internet of Things (IoT) 

IoT adalah akses perangkat elektronik melalui 

internet. Akses perangkat tersebut terjadi karena 

keinginan untuk berbagi data, berbagi akses. 

Pengembangan IoT Arduino adalah memanfaatkan 

board dasar Arduino Uno atau Arduino Wi-Fi dan 

pengembangan board yang mendudukng seperti 

Ethernet dan ESP (Wasista et al., 2019).  

 
sumber: mobnasesemka.com 

Gambar 1. Konsep IoT 

 

MQTT  (Message Queue Telemetry Transport) 

Protokol MQTT  adalah protokol pesan ringan 

(lightweight) berbasis publish-subscribe digunakan 

di atas protokol TCP/IP. MQTT mampu menangani 

ribuan client jarak jauh dengan hanya satu server 

(Saputra et al., 2017). 

 
sumber: https://medium.com/pemrograman/mengenal-

mqtt-998b6271f585 

Gambar 2. Arsitektur MQTT 

 

MQTT Broker  

Server/Broker MQTT menggunakan perangkat 

lunak Mosquitto yang dapat berjalan pada sistem 

operasi Windows, ataupun Linux. Eclipse mosquitto 

™ merupakan broker pesan open source (EPL/EDL 

berlisensi) yang mengimplementasikan MQTT 

protokol versi 3.1 dan 3.1.1. Server broker MQTT 

secara default menggunakan port 1833 walaupun di 

dalam implementasinya server MQTT dapat 

menggunakan beberapa port lain dengan fungsi 

yang berbeda (Saputra et al., 2017). 

 

https://medium.com/pemrograman/mengenal-mqtt-998b6271f585
https://medium.com/pemrograman/mengenal-mqtt-998b6271f585
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Thinger.io 

Thinger.io adalah platform IoT yang 

menyediakan fitur cloud untuk menghubungkan 

berbagai perangkat yang terkoneksi dengan internet. 

Thinger.io juga dapat memvisualisasikan hasil 

pembacaan sensor dalam bentuk nilai atau grafik. 

(Sawidin et al., 2021). 

 

ESP8266 

ESP8266 adalah Wifi Serial Transceiver 

Module yang menawarkan networking Wi-Fi. 

ESP8266 memiliki kemampuan on-board prosesing 

dan storage yang memungkinkan chip tersebut 

untuk diintegrasikan dengan sensor atau aplikasi 

output hanya dengan pemrograman singkat. (Roihan 

et al., 2016). 

 
sumber: https://www.sinauarduino.com/artikel/esp8266/  

Gambar 3.  Modul Wi-Fi ESP8266 

 

Sensor MQ135 

Sensor MQ-135 adalah sensor gas yang 

memiliki konduksifitas rendah jika berada di udara 

bersih. Konduktivitas sensor akan naik seiring 

dengan kenaikan konsentrasi gas (Indahwati & 

Nurhayati, 2012). 

 
sumber: https://bt-electronic.com/product/arduino-

sensor-gas-mq-135/ 

Gambar 4. Sensor MQ135 

 

Sensor PMS5003  

PMS5003 adalah sejenis sensor konsentrasi 

partikel digital dan universal, yang dapat digunakan 

untuk mendapatkan jumlah partikel tersuspensi di 

udara, yaitu konsentrasi partikel, dan 

mengeluarkannya dalam bentuk digital antarmuka 

(Helman, 2021). 

 
sumber: https://www.distrelec.biz/en/pms5003-air-

quality-sensor-kit-5v-adafruit-3686/p/30139173 

Gambar 5. Sensor PMS5003 

 

Sensor DHT2 

Kelembapan adalah salah satu faktor yang 

menentukan kondisi cuaca pada suatu daerah. 

Kelembapan dapat diukur dengan berbagai macam 

metode, salah satunya adalah dengan menggunakan 

sensor kelembapan (Irmayani et al., 2020). 

 
sumber: https://electropeak.com/am2301-dht21-1 

Gambar 6. Sensor DHT21 

 

LED (Light Emitting Diode) 

LED merupakan komponen yang dapat 

memancarkan cahaya monokromatik. Komponen 

LED yang menghasilkan cahaya yang sangat terang 

ini, pada masa sekarang juga banyak digunakan 

sebagai pengganti lampu pijar (Palgunadi, 2021). 

 
sumber: https://www.amazon.in/REES52-Traffic-Light-

Emitting-Digital-Electronic/dp/B07M8V3TZ4 

Gambar 7. LED 

 

Buzzer 

Buzzer adalah komponen elektronika yang 

berfungsi untuk mengubah listrik menjadi suara. 

Buzzer biasa digunakan sebagai indikator bahwa 

proses telah selesai atau terjadi suatu kesalahan pada 

sebuah alat (alarm) (Christian & Komar, 2013).  

 
sumber: https://sariteknologi.com/product/buzzer 

Gambar 8. Buzzer 

 

LCD (Liquid Crystal Display) 20x4  

LCD yang digunakan adalah LCD berukuran 

20x4 karakter dengan tambahan chip module I2C 

untuk mempermudah programmer nantinya dalam 

mengakses LCD tersebut. (Nirwan & MS, 2020). 

 
sumber:https://id.aliexpress.com/item/32680818723.html 

Gambar 9. LCD 

 

III. METODOLOGI PENELITIAN 

 

Tahapan Penelitian 

Untuk mendapatkan data yang akurat serta alur 

penelitian yang sesuai maka perlu dibuat alur yang 

jelas untuk memperoleh data dan informasi yang 

https://www.sinauarduino.com/artikel/esp8266/
https://bt-electronic.com/product/arduino-sensor-gas-mq-135/
https://bt-electronic.com/product/arduino-sensor-gas-mq-135/
https://www.distrelec.biz/en/pms5003-air-quality-sensor-kit-5v-adafruit-3686/p/30139173
https://www.distrelec.biz/en/pms5003-air-quality-sensor-kit-5v-adafruit-3686/p/30139173
https://electropeak.com/am2301-dht21-1


 

Jurnal PROSISKO Vol. 10 No. 2 September 2023 
p-ISSN : 2406-7733 

                         e-ISSN : 2597-9922 

 

155 

 

diperlukan secara lengkap, untuk mendukung 

kebenaran meteri dan pembahasan. Berikut tahapan 

penelitian yang akan dijelaskan: 

1. Studi literatur. Kegiatan ini dilakukan untuk 

memperkuat proses penelitian yang dilakukan. 

2. Pengumpulan data dan analisis kebutuhan. 

Kegiatan ini dilakukan untuk mengumpulkan 

data penelitian berbagai sumber yang 

diperlukan dalam membuat prototype ini. 

3. Perancangan dan pembuatan prototype. 

Konsep dirancang dari berbagai sumber teori 

dan referensi yang berkaitan dengan alat yang 

akan dirancang.  

4. Pengujian alat. Pengujian alat ini dilakukan 

dengan cara mencocokkan kinerja dari 

perangkat dengan perintah program yang 

dieksekusi. 

5. Analisis hasil pengujian. Analisis hasil 

pengujian ini dilakukan dengan 

membandingkan data yang dikirim dari 

prototype dan data yang diterima melalui 

aplikasi mobile atau website Thinger.io 

sehingga bisa ditentukan alat bekerja dengan 

sempurna. 

6. Penyusunan dan pembuatan laporan. 

 
Gambar 10. Diagram Alur Penelitian 

 

Kebutuhan Hardware/ Perangkat Keras 

Hardware yang diperlukan untuk menerapkan 

sistem pengukuran kepekatan debu berbasis MQTT 

Server adalah sebagai berikut: 

Tabel 2. Kebutuhan Hardware/ Perangkat Keras 

No. Hardware Spesifikasi 

1. Laptop 
Windows 10, Memory 4GB, 

AMD Dual Core A9-9425. 

2. ESP8266 

Wi-Fi ESP8266, 1 ADC, 4MB 
Flash Memory, 16 Pin digital 

input dan output, Tegangan 9v-

24Vdc. 

3. 
Sensor 
MQ135 

Tegangan: 5V, ADC dengan 

resolusi 10bit, pin i/o kompatibel 
dengan level tegangan TTL dan 

cmos, antarmuka UART TTL dan 

I2C. 

4. 
Sensor 

PMS5003 

Respon waktu nyata, data yang 

benar, diameter partikel 

minimum: 0,3 mikrometer. 

5. 
Sensor 

DHT21 

Tegangan: 3.3-5.5V, rentang 
pengukuran: kelembapan 0-100% 

RH, suhu 40-80 Celcius, dimensi 

ukuran: 59x27x15,5mm. 

6. 

LED 

Traffic 

Light 

Tegangan: 5V, common 

cathode/GND jadi satu, ukuran 

led: 8mm. 

7. Buzzer 

Tegangan kerja: 3V-12V DC, 

Resistansi: 16 ohm, Kekuatan 
suara: 80-85 dB, Kualitas tinggi: 

12x8.5mm. 

 

Kebutuhan Software/ Perangkat Lunak 

Spesifikasi perangkat lunak yang dibutuhkan 

untuk mengoperasikan dan pembuatan sistem 

pengukuran partikel debu dan suhu udara ini adalah: 

1. Arduino IDE 

2. Thinger.io 

3. Mosquitto 

4. MQTT Dash 

5. Command Prompt 

 

Data Penelitian 

Adapun data yang sudah didapatkan dari hasil 

wawancara adalah: 

1. Perlu adanya sistem berbasis web untuk dapat 

memberikan informasi tingkat pencemaran 

secara cepat dan tepat kepada masyarakat. 

2. Belum adanya alarm peringatan ketika polusi 

udara sudah melebihi batas ambang. 

 

Tabel 3. Data dan Analisis ISPU Bulan Februari 

No. 
PM 

10 

PM 

2.5 
SO2 CO O3 NO2 

1 34 72 215 24 194 73 

2 34 72 216 23 197 73 

3 31 68 213 23 196 73 

4 25 61 212 23 204 74 

5 17 52 215 22 210 72 

6 13 38 216 22 212 73 

7 12 51 216 23 211 73 
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No. 
PM 

10 

PM 

2.5 
SO2 CO O3 NO2 

8 20 63 215 24 210 68 

9 30 77 217 24 212 70 

10 8 35 216 21 214 67 

11 0 0 0 0 0 0 

12 0 0 0 0 0 0 

13 0 0 0 0 0 0 

14 0 0 0 0 0 0 

15 0 0 0 0 0 0 

16 0 0 0 0 0 0 

17 0 0 0 0 0 0 

18 0 0 0 0 0 0 

19 0 0 0 0 0 0 

20 0 0 0 0 0 0 

 

Tabel 4. Data dan Analisa ISPU Bulan Maret 

No. 
PM 

10 

PM 

2.5 
SO2 CO O3 NO2 

1 0 0 0 0 0 0 

2 0 0 0 0 0 0 

3 0 0 0 0 0 0 

4 13 35 212 28 126 74 

5 0 0 0 0 0 0 

6 0 0 0 0 0 0 

7 0 0 0 0 0 0 

8 0 0 0 0 0 0 

9 19 42 217 30 110 104 

10 33 62 219 27 207 102 

11 23 53 217 26 211 94 

12 17 35 220 18 207 88 

13 0 0 0 0 0 0 

14 0 0 0 0 0 0 

15 0 0 0 0 0 0 

16 19 40 215 28 233 65 

17 39 0 215 26 233 66 

18 36 0 217 25 233 66 

19 16 0 217 24 235 66 

20 12 0 217 22 237 66 

21 10 0 216 22 234 73 

22 13 0 217 22 236 76 

23 24 0 218 23 239 76 

24 20 0 216 24 238 75 

25 54 0 214 24 237 78 

26 0 0 0 0 0 0 

No. 
PM 

10 

PM 

2.5 
SO2 CO O3 NO2 

27 0 0 0 0 0 0 

28 0 0 0 0 0 0 

29 0 0 0 0 0 0 

30 0 0 212 23 291 34 

31 0 0 218 25 279 38 

 

Tabel 5. Data dan Analisis ISPU Bulan April 

No. 
PM 

10 

PM 

2.5 
SO2 CO O3 NO2 

1 0 0 218 25 261 45 

2 0 0 218 23 256 57 

3 0 0 217 21 249 63 

4 0 0 0 0 0 0 

5 0 0 0 0 0 0 

6 0 0 218 20 258 95 

7 0 0 223 22 260 106 

8 0 0 238 25 252 105 

9 0 0 0 0 0 0 

10 0 0 234 19 247 103 

11 0 0 224 23 254 103 

12 0 0 221 26 255 103 

 

Deskripsi Usulan Penelitian 

Pada penelitian ini melakukan perancangan 

teknologi sistem pengukuran partikel debu dan suhu 

udara, yang bertujuan untuk memudahkan dalam 

mengukur partikel debu dan suhu udara.  

 
Gambar 11. Diagram Alur Kerja Prototype 
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Pengukuran sudah efisien namun belum bisa 

di-monitoring jarak jauh secara online. Sistem 

pengukuran partikel debu dan suhu udara berbasis 

MQTT Server menggunakan Sensor MQ135, Sensor 

PMS5003, Sensor DHT21, ESP8266 sebagai 

mikrokontroler yang dapat membaca saat 

mengetahui partikel debu dan suhu udara, bagian 

tampilan sistemnya akan ditampilkan ke dalam 

platform IoT yaitu website Thinger.io yang nantinya 

hasil pengujian spesifikasi input yang diperoleh 

menunjukkan kesesuaian antara klasifikasi ISPU 

berdasarkan lokasi dan waktu pengambilan data. 

 

 
Gambar 12. Alur Kerja Message Broker MQTT 

 

 
Gambar 13. Topologi Devices 

 

 
Gambar 14. Sistem Pilot MQTT Dash 

 

Langkah-langkah instalasi software Arduino IDE 

Sebelum melakukan perancangan dan 

pemograman alat, langkah pertama yang harus 

dilakukan adalah menginstall suatu software 

Arduino IDE dan library untuk melakukan 

pemograman alat. 

1. Setelah file instalasi dijalankan, maka akan 

muncul tampilan jendela Arduino Setup: 

License Agreement seperti gambar 15, lalu klik 

tombol I Agree. 

 
Gambar 15. License Agreement 

 

2. Setelah klik tombol I Agree, lalu tampilan 

jendela menampilkan Arduino Setup: 

Installation Options. Untuk komponen, 

sebaiknya di centang semua. 

 
Gambar 16. Installation Options 

 

3. Berikutnya akan muncul tampilan jendela 

Installation Folder, yang dimana akan 

menampilkan destinasi/tempat folder Arduino 

IDE yang akan kita simpan, lalu klik Install. 

 

 
Gambar 17. Installation Folder 

 

4. Proses instalasi akan dimulai dan tunggu 

sampai instalasi completed. 
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Gambar 18. Installing 

 

5. Software Arduino IDE sudah terinstall. 

 
Gambar 19. Tampilan Software Arduino 

 

Langkah-langkah konfigurasi Platform IoT 

Thinger.io 

Pada tahap ini yang harus dilakukan adalah 

membuka Thinger.io di website https://thinger.io/, 

untuk melakukan sistem pengukuran partikel debu 

dan suhu udara melalui laptop. Jika sudah membuka 

website tersebut, maka akan melakukan langkah-

langkah konfigurasi sebagai berikut: 

1. Pertama, buka https://thinger.io/ di website. Di 

pojok kanan atas terdapat sign up atau login, 

jika belum mendaftar, maka klik sign up, 

namun jika sudah, klik login. Login email dan 

password yang sebelumnya sudah dibuat. 

 
Gambar 20. Tampilan Awal website Thinger.io 

 

2. Setelah login, buka software Arduino IDE 

terlebih dahulu untuk menambahkan library 

thinger.io. Klik Sketch > Include Library > 

Manage Library lalu cari “thinger.io” dan 

lakukan penginstallan jika belum terinstall. 

 
Gambar 21. Proses install Library Thinger.io 

 

3. Setelah library terinstall, buka example untuk 

melihat contoh program bisa kita klik File > 

Examples > thinger.io > ESP8266 > ESP8266. 

 
Gambar 22. Tampilan Step Examples Thinger.io 

 

4. Selanjutnya, kembali buka website Thinger.io 

> Devices > Add Devices > isi Devices 

Configuration & Devices Information. 

 
Gambar 23. Konfigurasi Devices dan Information 

 

5. Berikutnya masukkan ke dalam program, 

seperti username, devices_id, 

devices_credential menyesuaikan dari 

Thinger.io pada gambar sebelumnya. 

 
Gambar 24. Tampilan Program Thinger.io 

 

https://thinger.io/
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6. Jika sudah, maka akan menampilkan halaman 

seperti gambar 25. 

 
Gambar 25. Tampilan Thinger.io 

 

Tahapan pemograman mikrokontroler Arduino 

IDE 

Sebelum menulis program, meng-install 

terlebih dahulu library yang dibutuhkan di software 

Arduino IDE agar dapat bisa mendukung board 

ESP8266 yang digunakan, pengaturan yang dibuat 

adalah sebagai berikut: 

1. Buka bagian File > Preference > di kotak 

Additional Board Manage URL Input link: 

http://arduino.esp8266.com/stable/package_e

sp8266com_index.json 

2. Selanjutnya buka bagian Tools > Boards > 

Board Manager, cari “ESP8266”, pada daftar 

akan muncul “esp8266 by ESP8266 

Community dan install versi terakhirnya. 

3. Selanjutnya buka bagian Sketch > Include 

Libraries > Manage Libraries, cari 

“Thinger.io”, pada daftar akan muncul 

“Thinger.io by Thinger.io” dan install versi 

terakhirnya. 

4. Selanjutnya pengaturan pada bagian Tools 

Board sorot dan pilih “ESP8266 Borad dan 

LOLIN(WEMOS) D1 R2 & mini”. 

5. Pada bagian Tools Progammer sorot dan pilih 

“ARDUINOISP”. 

6. Tulis kode pemograman pada halaman yang 

disediakan, Upload kode yang telah dibuat, 

jika terdapat keterangan done uploding maka 

proses pemograman mikrokontroler dengan 

Arduino IDE berhasil. 

 

Konfigurasi Pada MQTT (Mosquitto) 

 Pada konfigurasi ini yang harus dilakukan 

adalah mendownload software Mosquitto di website 

http://mosquitto.org. Jika sudah men-download, 

maka melakukan langkah-langkah konfigurasi 

sebagai berikut: 

1. Setelah men-download, buka software pada 

folder instalasi. Klik next untuk melanjutkan 

instalasi. 

 
Gambar 26. Tampilan awal install Mosquitto 

 

2. Selanjutnya pada Choose Component pilih 

komponen yang ingin di-install, sebaiknya 

dicentang semua, lalu klik next. 

 
Gambar 27. Choose Component 

 

3. Pilih lokasi folder untuk instalasi, C:\Program 

Files\mosquitto adalah destination folder dan 

klik install tunggu sampai proses instalasi 

selesai. 

 
Gambar 28. Destination Folder 

 

4. Proses instalasi selesai. 

http://mosquitto.org/
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Gambar 29. Completing Mosquitto Setup 

 

5. Kemudian, buka command prompt untuk 

mengetes mosquito. Masukkan “net start 

mosquito” lalu enter dan akan muncul “The 

Mosquitto Broker service is starting” tunggu 

sejenak. Jika merespon maka akan 

menampilakn “The Mosquitto Broker service 

was started successfully”. 

 
Gambar 30. Mosquitto Successfully. 

 

Konfigurasi Pada MQTT Dash 

Berikut konfigurasi dengan ESP8266 dan 

broker MQTT di CloudMQTT yang dikonfigurasi 

untuk mengontrol dari jarak jauh melalui internet: 

1. Download terlebih dahulu aplikasi MQTT 

Dash di Playstore. 

 
Gambar 31. Downloading MQTT Dash 

 

2. Klik logo tambah pada pojok kanan atas, lalu 

masukan name, address, dan port. Untuk 

address, samakan dengan program MQTT-

ESP8266 pada Arduino IDE yaitu 

test.mosquitto.org setelah itu klik save. 

 
Gambar 32. Konfigurasi Awal MQTT Dash 

 

3. Masukkan “name” dan “topic” untuk 

mengidentifikasi pesan yang dipublikasikan 

dengan memberikan nama topic seperti pada 

gambar 33. 

 
Gambar 33. Pengukuran suhu  
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Gambar 34. Pengukuran kelembaban 

 

Rancangan Produk 

Skema jaringan sistem pengukuran partikel 

debu dan suhu udara berbasis MQTT Server 

menggunakan mikrokontroller ESP82666 

terkoneksi ke jaringan internet. Hasil pembacaan 

sensor-sensor: debu, suhu, akan diterima oleh 

ESP8266. Data ini juga akan dikirimkan melalui 

internet dan ditampilkan di website Thinger.io. 

Untuk melakukan kalkulasi dari pengukuran Sensor 

MQ135, Sensor PMS5003 dan Sensor DHT21, data-

data tersebut dikirimkan ke module Wi-Fi ESP8266. 

  
Gambar 35. Blok Diagram Alat  

 

 

 

V.  HASIL DAN PEMBAHASAN 

 

Hasil Penelitian 

Hasil penelitian awal diketahui bahwa 

komunikasi nirkabel pada modul LoRa dapat 

mengirimkan data sejauh 3,7 km secara linier 

(searah) dengan bandwidth jaringan paling besar 

4,8Mbps dan paling kecil sebesar 2,6Kbps. Semakin 

jauh pengiriman data sensor, maka bandwidth yang 

diperlukan pun semakin besar.  

 

Tabel 6. Pengujian Awal 

No. Uji Kasus Hasil yang Diperoleh 

1. 
Pengujian pada node 

gateway ESP8266. 

Dapat menghubungkan 

Modul Node Gateway 

ke jaringan internet. 

2. 

Pengujian input Sensor 

Gas untuk Sensor 

MQ135. 

Dapat berjalan dan 

berfungsi dengan baik. 

3. 

Pengujian input Sensor 

Suhu dan Kelembaban 

untuk Sensor DHT21. 

Dapat berjalan dan 

berfungsi dengan baik. 

4. 

Pengujian input Sensor 

Debu untuk Sensor 

PMS5003. 

Dapat berjalan dan 
berfungsi dengan baik, 

hasil pembacaan sensor 

responsif. 

5. 
Pengujian Dashboard 

Thinger.io. 

Dapat menampilkan 

data-data yang sudah di 

program kedalam 
dashboard. 

 

LoRa Sender 

Node sensor, proses pengiriman/komunikasi 

data menggunakan Pin SPI (Serial Peripheral 

Interface) dari modul Arduino ke LoRa. 

 
Gambar 36. Komunikasi Data LoRa Sender 

 

LoRa Receiver dan Node Gateway (G1 > LoRa & 

RS232) 

Data yang diterima dari node sensor, 

dikirimkan ke komunikasi data RS232 dari slave 

(pengirim [G1]) > master (penerima [G2]) secara 

simplex. Kemudian data yang diterima di-parsing 

untuk dikirimkan ke gateway. Proses pengiriman 

dilakukan di beberapa titik. 
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Tabel 7. Hasil Komunikasi Data dari LoRa Sender 

(1) 

Titik 

Sensor MQ135 

(Gas) 

Sensor 

DHT21 

(Kelembaban) 

PPM Ket RH % 

1 3,74 ppm Sehat 52,50 RH % 

2 3,61 ppm Sehat 52,50 RH % 

3 3,13 ppm Sehat 52,70 RH % 

4 2,67 ppm Sehat 55,1 RH % 

5 2,71 ppm Sehat 70,5 RH % 

 

Tabel 8. Hasil Komunikasi Data dari LoRa Sender 

(2) 

Titik 

Sensor DHT21 

(Suhu) 

Sensor PMS5003 

(Kepekatan Debu) 

Normal 
Tidak 

Normal 

PM 

2,5 
Ket 

PM 

10 
Ket 

1 
30,7 

0C 

33,90 
0C 

77 

ug/m3 
Sedang 

80 

ug/m3 
Sedang 

2 
31,1 

0C 
32 0C 

72 

ug/m3 
Sedang 

83 

ug/m3 
Sedang 

3 29 0C 
33,60 

0C 

74 

ug/m3 
Sedang 

83 

ug/m3 
Sedang 

4 
31,9 

0C 
36 0C 

80 

ug/m3 
Sedang 

88 

ug/m3 
Sedang 

5 
29,9 

0C 

33,20 
0C 

72 

ug/m3 
Sedang 

85 

ug/m3 
Sedang 

 

Komunikasi RS232 

Pengiriman dari Node Sensor (transmitter), 

mengirimkan data ke Node Process (receiver) yang 

menggunakan port serial RS232 melalui LoRa. 

Setelah mendapatkan data, receiver melakukan 

pengiriman ulang ke server untuk divisualisasikan 

di aplikasi, kemudian server juga melakukan 

permintaan ulang data pada receiver. Proses dari 

receiver > server maupun sebaliknya, dilakukan 

secara half duplex yang dapat ditransmisikan atau 

diterima secara dua arah tapi tidak dapat secara 

bersama-sama. 

 

MQTT Server 

ESP8266 akan mengirimkan topic bernama 

/temp/subs/ dan /humidity/subs/ hanya sebagai 

sistem pilot ke dalam MQTT Broker. Sensor 

mengirim data ke MQTT Broker yang mana setiap 

devices yang subscribe ke MQTT Broker, akan 

diberikan data dari sensor dan datanya secara real 

time.  

 

Hasil Penelitian Akhir 

Dalam penelitian ini didapatkan data sensor 

melalui proses komunikasi data sebagai berikut 

berdasarkan tabel 9. 

 

 

 

 

 

Tabel 9. Hasil pengujian Alat 

No. 
Jenis 

Komponen 
Normal 

Tidak 

Normal 

1. 
Sensor 

MQ135 

Gas pada udara 

(0-10 ppm) 

Gas pada 

udara 

(> 0-10 ppm) 

2.  
Sensor 

PMS5003 

Partikel Debu 

(0-100 mikron) 

Partikel Debu 

(> 100 

mikron) 

3. 
Sensor 

DHT21 

Suhu pada 

udara 
(21-33 oC) 

Suhu pada 

udara 
(> 33 oC) 

4. Buzzer Alarm diam 
Alarm 
berbunyi 

5. LCD 
Menampilkan 
hasil 

pengukuran 

Menampilkan 
hasil 

pengukuran 

6. LED 
LED hijau 

menyala 

LED merah 

menyala 

 

Pengujian Aplikasi 

Tampilan akhir dari proses komunikasi data 

berupa tampilan visualisasi data sensor yang dapat 

di akses melalui website Thinger.io dan MQTT Dash 

seperti pada gambar 36. 

 
Gambar 36. Tampilan Hasil Pengukuran Sensor 

pada Thinger.io. 

 

Tampilan sistem pilot pada MQTT Dash. 

 
Gambar 37. Tampilan Sistem Pilot MQTT Dash 

 

Hasil Pengujian ESP8266 

Pengujian ESP8266 ini menggunakan 

smartphone dengan hasil pengujiannya dapat dilihat 

pada tabel 10. 
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Tabel 10. Hasil Pengujian ESP8266 

No. Bandwidth 
Kecepatan 

Transfer 
Jarak RSSI Ket 

1. 4,8 Mbps 44ms 250 m -98 Terkirim 

2. 970 Kbps 37ms 550 m -115 Terkirim 

3. 1,3 Mbps 50ms 1,7 km -114 Terkirim 

4. 26 Kbps 37ms 2,7 km -114 Terkirim 

5. 750 Kbps 51ms 3,7 km -115 Terkirim 

 

Hasil perbandingan antara protokol MQTT 

Server dengan HTTPS terlihat pada tabel 11.  

 

Tabel 11. Perbandingan HTTPS dengan MQTT 

No. 
Kecepatan 

Transfer HTTPS 

Kecepatan Transfer 

MQTT 

1. 58,50 detik 15,34 detik 

2. 24,63 detik 14,02 detik 

3. 1 menit 17 detik 16,22 detik 

4. 57,34 detik 23,14 detik 

5. 45,41 detik 20,09 detik 

 

Pembahasan 

Dalam penggunaannya komunikasi dengan 

protokol MQTT lebih banyak dipakai daripada 

HTTP, karena protokol MQTT menggunakan daya 

yang lebih sedikit dari protokol HTTP pada setiap 

jamnya saat pengiriman data, artinya protokol 

MQTT dapat mengurangi konsumsi daya dan juga 

lebih cepat dari protokol HTTP. MQTT mengirim 

data sebagai byte array dengan model 

publish/subscribe, dimana ini cocok untuk 

perangkat dengan sumber daya terbatas dan lebih 

menghemat energi. Menurut pengukuran dengan 

jaringan 3G, MQTT 93 kali lebih cepat daripada 

HTTP. MQTT lebih cocok digunakan untuk Internet 

of Things yang bisa untuk mengirim lebih cepat 

dengan sumber daya bandwidth yang terbatas. 

Berdasarkan hasil pengujian, sistem 

monitoring polusi udara dan kepekatan debu dapat 

bekerja dengan baik dimana Sensor MQ135 dapat 

mengukur gas udara pada kisaran 1-10 ppm, Sensor 

DHT21 dapat mengukur suhu udara pada kisaran 

290C-330C, Sensor PMS5003 dapat mengukur 

kepekatan debu pada udara dan diketahui jika hasil 

perbandingan sensor PMS5003 dengan data-data 

analisa oleh Dinas Lingkungan Hidup memiliki 

perbedaan yang sangat tinggi pada pengukuran 

partikel PM 10 dan perbandingan pengukuran 

partikel PM 2,5 tidak begitu jauh. Dari pengujian 

pengiriman data informasi ke prototype ke website 

Thinger.io telah dilakukan pengujian sebanyak 5 

kali dan membutuhkan 4,8 Mbps dengan kecepatan 

transfer 44ms. Dengan mengunakan perangkat 

ESP8266, sensor PMS5003, sensor DHT21 serta 

aplikasi MQTT Dash pada smartphone dan website 

Thinger.io proses pengukuran polusi udara dan 

kepekatan debu dapat dilakukan dari jarak jauh 

dengan memanfaatkan jaringan internet. 

 

V. PENUTUP 

 

Kesimpulan  

Berdasarkan hasil penelitian dan pengujian 

yang telah dilakukan, maka dapat disimpulkan: 

1. Sistem pengukuran partikel debu dan suhu 

udara ini memerlukan ESP8266 sebagai 

mikrokontroler, LCD 20x4 sebagai tampilan 

output hasil pengukuran, Sensor MQ135 untuk 

mengukur gas pada udara, Sensor PMS5003 

untuk mengukur kepekatan debu, Sensor 

DHT21 untuk mengukur suhu dan 

kelembaban, LED dan Buzzer sebagai 

indikator. Arduino IDE untuk pemrograman, 

Thinger.io sebagai visualisasi hasil 

pengukuran, Mosquitto sebagai Message 

Broker, MQTT Dash sebagai penampil hasil 

pengukuran suhu dan kelembaban, Command 

Prompt yang digunakan untuk melakukan test 

ping. 

2. Sistem ini dapat memonitoring dan 

menampilkan data-data hasil pengukuran 

dengan nilai bandwidth minimal 4,8Mbps, 

kecepatan data transfer paling cepat 14,02 

detik, jarak maksimal pengukuran dari titik ke 

titik 3,7 km. 

 

Saran 

Berdasarkan penelitian yang telah dilakukan, 

beberapa saran yang dapat dikembangkan pada 

penelitian selanjutnya yaitu untuk penambahan 

perangkat, disarankan menggunakan mini computer 

(Raspberry Pi 3B+) supaya bisa lebih 

mengoptimalkan perangkat yang belum terancang 

menjadi satu. 
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